VERY LARGE TELESCOPE

Reflex VIMOS/MOS Tutorial

VLT-MAN-ESO-19500-....

Issue 4.1.8
Date May 19th 2023

Prepared: ESO VIMOS Pipeline Team
Name
Date
Signature

Approved: W. Freudling
Name
Date
Signature

Released: M. Sterzik
Name
Date
Signature
## Change record

<table>
<thead>
<tr>
<th>Issue/Rev.</th>
<th>Date</th>
<th>Section/Parag. affected</th>
<th>Reason/Initiation/Documents/Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>April 2013</td>
<td>All</td>
<td>First public release 2.9.15</td>
</tr>
<tr>
<td>2.0</td>
<td>April 2016</td>
<td>All</td>
<td>Update for public release 3.1.3</td>
</tr>
<tr>
<td>2.4</td>
<td>May 2021</td>
<td>All</td>
<td>Update for public release 4.1.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>page 39</td>
<td>New Q&amp;A added</td>
</tr>
<tr>
<td>2.5</td>
<td>May 2022</td>
<td>All</td>
<td>Update for public release 4.1.7</td>
</tr>
<tr>
<td>4.1.8</td>
<td>May 2023</td>
<td>None</td>
<td>Update for public release 4.1.8</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>version number aligned, bugfix in workflow</td>
</tr>
</tbody>
</table>
Contents

1 Introduction to EsoReflex 7

2 Software Installation 8
   2.1 Installing Reflex workflows via macports ................................. 8
   2.2 Installing Reflex workflows via rpm/yum/dnf ............................. 8
   2.3 Installing Reflex workflows via install_esoreflex ....................... 9
   2.4 Demo Data .............................................................................. 10

3 Quick Start: Reducing The Demo Data 11

4 About the main esoreflex canvas 15
   4.1 Saving And Loading Workflows .............................................. 15
   4.2 Buttons ................................................................................. 15
   4.3 Workflow States ..................................................................... 15

5 The VIMOS Workflow 16
   5.1 Workflow Canvas Parameters .................................................. 16
   5.2 Workflow Actors ..................................................................... 17
      5.2.1 Simple Actors .................................................................... 17
      5.2.2 Composite Actors ............................................................... 17
      5.2.3 Recipe Execution within Composite Actors ......................... 18
      5.2.4 Lazy Mode ....................................................................... 20

6 Reducing your own data 22
   6.1 The esoreflex command ............................................................. 22
   6.2 Launching the workflow ............................................................ 22
   6.3 Workflow Steps ....................................................................... 24
      6.3.1 Data Organisation And Selection ....................................... 24
      6.3.2 DataSetChooser ................................................................. 26
      6.3.3 The ProductExplorer ......................................................... 26
      6.3.4 Creation Of Master Calibration Files ................................. 28
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.3.5</td>
<td>Response Computation</td>
<td>29</td>
</tr>
<tr>
<td>6.3.6</td>
<td>Science Reduction</td>
<td>29</td>
</tr>
<tr>
<td>6.3.7</td>
<td>Output Organisation</td>
<td>29</td>
</tr>
<tr>
<td>6.4</td>
<td>Interactive Windows</td>
<td>30</td>
</tr>
<tr>
<td>6.4.1</td>
<td>vmmoscalib</td>
<td>31</td>
</tr>
<tr>
<td>6.4.2</td>
<td>vmmossceince (Response)</td>
<td>31</td>
</tr>
<tr>
<td>6.4.3</td>
<td>vmmossceince (Science)</td>
<td>32</td>
</tr>
<tr>
<td>7</td>
<td>Improving Your Results Through Workflow Interaction</td>
<td>34</td>
</tr>
<tr>
<td>7.1</td>
<td>Demo Data</td>
<td>34</td>
</tr>
<tr>
<td>7.2</td>
<td>Wavelength Calibration</td>
<td>34</td>
</tr>
<tr>
<td>8</td>
<td>Frequently Asked Questions</td>
<td>35</td>
</tr>
<tr>
<td>8.1</td>
<td>VIMOS specific questions</td>
<td>37</td>
</tr>
<tr>
<td>9</td>
<td>Troubleshooting</td>
<td>41</td>
</tr>
</tbody>
</table>
1 Introduction to EsoReflex

This document is a tutorial designed to enable the user to to reduce his/her data with the ESO pipeline run under an user-friendly environmet, called EsoReflex, concentrating on high-level issues such as data reduction quality and signal-to-noise (S/N) optimisation.

EsoReflex is the ESO Recipe Flexible Execution Workbench, an environment to run ESO VLT pipelines which employs a workflow engine to provide a real-time visual representation of a data reduction cascade, called a workflow, which can be easily understood by most astronomers. The basic philosophy and concepts of Reflex have been discussed by Freudling et al. (2013A&A...559A..96F). Please reference this article if you use Reflex in a scientific publication.

Reflex and the data reduction workflows have been developed by ESO and instrument consortia and they are fully supported. If you have any issue, please have a look to https://support.eso.org to see if this has been reported before or open a ticket for further support.

A workflow accepts science and calibration data, as downloaded from the archive using the CalSelector tool\(^1\) (with associated raw calibrations) and organises them into DataSets, where each DataSet contains one science object observation (possibly consisting of several science files) and all associated raw and static calibrations required for a successful data reduction. The data organisation process is fully automatic, which is a major time-saving feature provided by the software. The DataSets selected by the user for reduction are fed to the workflow which executes the relevant pipeline recipes (or stages) in the correct order. Full control of the various recipe parameters is available within the workflow, and the workflow deals automatically with optional recipe inputs via built-in conditional branches. Additionally, the workflow stores the reduced final data products in a logically organised directory structure employing user-configurable file names.

This tutorial deals with the reduction of VIMOS MOS spectroscopic observations only via the VIMOS/MOS workflow. The user is referred to the VIMOS web page (http://www.eso.org/sci/facilities/paranal/instruments/vimos/) for more information on the instrument itself, and the VIMOS pipeline user manual for the details of the pipeline recipes (http://www.eso.org/sci/software/pipelines/).

The workflow uses association rules known to work with files downloaded from the ESO archive with the CalSelector tool (from year 2009 onwards).

\(^1\)http://www.eso.org/sci/archive/calselectorInfo.html
2 Software Installation

Esoreflex and the workflows can be installed in different ways: via package repositories, via the install_esoreflex script or manually installing the software tar files.

The recommended way is to use the package repositories if your operating system is supported. The macports repositories support macOS 10.14 to 11, while the rpm/yum repositories support Fedora 28 to 32, CentOS 7, Scientific Linux 7. For any other operating system it is recommended to use the install_esoreflex script.

The installation from package repository requires administrative privileges (typically granted via sudo), as it installs files in system-wide directories under the control of the package manager. If you want a local installation, or you do not have sudo privileges, or if you want to manage different installations on different directories, then use the install_esoreflex script. Note that the script installation requires that your system fulfill several software prerequisites, which might also need sudo privileges.

Reflex 2.11.x needs java JDK 11 to be installed.

Please note that in case of major or minor (affecting the first two digit numbers) Reflex upgrades, the user should erase the $HOME/KeplerData, $HOME/.kepler directories if present, to prevent possible aborts (i.e. a hard crash) of the esoreflex process.

2.1 Installing Reflex workflows via macports

This method is supported for the macOS operating system. It is assumed that macports (http://www.macports.org) is installed. Please read the full documentation at http://www.eso.org/sci/software/pipelines/installation/macports.html.

2.2 Installing Reflex workflows via rpm/yum/dnf

This method is supported for Fedora 28 to 32, CentOS 7, Scientific Linux 7 operating systems, and requires sudo rights. To install, please follow these steps

1. Configure the ESO repository (This step is only necessary if the ESO repository has not already been previously configured).
   - If you are running Fedora, run the following commands:
     
```bash
sudo dnf install dnf-plugins-core
    pipelines/repositories/stable/fedora/esorepo.repo
```

   - If you are running CentOS 7, run the following commands:
     
```bash
sudo yum install yum-utils ca-certificates yum-conf-repos
sudo yum install epel-release
    pipelines/repositories/stable/centos/esorepo.repo
```
• If you are running SL 7, run the following commands:
  
  ```bash
  sudo yum install yum-utils ca-certificates yum-conf-repos
  sudo yum install yum-conf-epel
  ```

2. Install the pipelines

• The list of available top level packages for different instruments is given by:
  
  ```bash
  sudo dnf list esopipe-*-all # (Fedora)
  sudo yum list esopipe-*all # (CentOS 7, SL 7)
  ```

• To install an individual pipeline use the following (This example is for X-Shooter. Adjust the package name to the instrument you require):
  
  ```bash
  sudo dnf install esopipe-xshoo-all # (Fedora)
  sudo yum install esopipe-xshoo-all # (CentOS 7, SL 7)
  ```

• To install all pipelines use:
  
  ```bash
  sudo dnf install esopipe-*all # (Fedora)
  sudo yum install esopipe-*all # (CentOS 7, SL 7)
  ```

For further information, please read the full documentation at [http://www.eso.org/sci/software/pipelines/installation/rpm.html](http://www.eso.org/sci/software/pipelines/installation/rpm.html).

2.3 Installing Reflex workflows via install_esoreflex

This method is recommended for operating systems other than what indicated above, or if the user has no sudo rights. Software dependencies are not fulfilled by the installation script, therefore the user has to install all the prerequisites before running the installation script.

The software pre-requisites for Reflex 2.11.5 may be found at: [http://www.eso.org/sci/software/pipelines/reflex_workflows](http://www.eso.org/sci/software/pipelines/reflex_workflows)

To install the Reflex 2.11.5 software and demo data, please follow these instructions:

1. From any directory, download the installation script:
  
  ```bash
  wget https://ftp.eso.org/pub/dfs/reflex/install_esoreflex
  ```

2. Make the installation script executable:
  
  ```bash
  chmod u+x install_esoreflex
  ```

3. Execute the installation script:
and the script will ask you to specify three directories: the download directory `<download_dir>`, the software installation directory `<install_dir>`, and the directory to be used to store the demo data `<data_dir>`. If you do not specify these directories, then the installation script will create them in the current directory with default names.

4. Follow all the script instructions; you will be asked whether to use your Internet connection (recommended: yes), the pipelines and demo-datasets to install (note that the installation will remove all previously installed pipelines that are found in the same installation directory).

5. To start Reflex, issue the command:

   `<install_dir>/bin/esoreflex`

   It may also be desirable to set up an alias command for starting the Reflex software, using the shell command `alias`. Alternatively, the PATH variable can be updated to contain the `<install_dir>/bin` directory.

### 2.4 Demo Data

Together with the pipeline you will also receive a demo data set, that allows you to run the Reflex VIMOS workflow without any changes in parameters. This way you have a data set to experiment with before you start to work on your own data. The demo data for VIMOS includes both data for the IFU and MOS workflows, but a given workflow will only use the data for that mode.

Note that you will need a minimum of ~1.3 GB, ~0.6 GB and ~7.0 GB of free disk space for the directories `<download_dir>`, `<install_dir>` and `<data_dir>`, respectively. The VIMOS demo data have been retrieved with the CalSelector tool

[2](http://www.eso.org/sci/archive/calselectorInfo.html)
3 Quick Start: Reducing The Demo Data

For the user who is keen on starting reductions without being distracted by detailed documentation, we describe the steps to be performed to reduce the science data provided in the VIMOS demo data set supplied with the esoreflex 2.11.5 release. By following these steps, the user should have enough information to perform a reduction of his/her own data without any further reading:

1. First, type:

   esoreflex -l

   If the esoreflex executable is not in your path, then you have to provide the command with the executable full path <install_dir>/bin/esoreflex -l. For convenience, we will drop the reference to <install_dir>. A list with the available esoreflex workflows will appear, showing the workflow names and their full path.

2. Open the VIMOS MOS by typing:

   esoreflex vimos_mos&

   Alternatively, you can type only the command esoreflex the empty canvas will appear (Figure 3.1) and you can select the workflow to open by clicking on File -> Open File. Note that the loaded workflow will appear in a new window. The VIMOS MOS workflow is shown in Figure 3.2.

3. To aid in the visual tracking of the reduction cascade, it is advisable to use component (or actor) highlighting. Click on Tools -> Animate at Runtime, enter the number of milliseconds representing the animation interval (100 ms is recommended), and click OK.

4. Change directories set-up. Under “Setup Directories” in the workflow canvas there are seven parameters that specify important directories (green dots).

   By default, the ROOT_DATA_DIR, which specifies the working directory within which the other directories are organised, is set to your $HOME/reflex_data directory. All the temporary and final products of the reduction will be organized under sub-directories of ROOT_DATA_DIR, therefore make sure this parameter points to a location where there is enough disk space. To change ROOT_DATA_DIR, double click on it and a pop-up window will appear allowing you to modify the directory string, which you may either edit directly, or use the Browse button to select the directory from a file browser. When you have finished, click OK to save your changes.

   Changing the value of RAW_DATA_DIR is the only necessary modification if you want to process data other than the demo data.

5. Click the button to start the workflow

6. The workflow will highlight the Data Organiser actor which recursively scans the raw data directory (specified by the parameter RAW_DATA_DIR under “Setup Directories” in the workflow canvas) and constructs the datasets. Note that the raw and static calibration data must be present either
in RAW_DATA_DIR or in CALIB_DATA_DIR, otherwise datasets may be incomplete and cannot be processed. However, if the same reference file was downloaded twice to different places this creates a problem as esoreflex cannot decide which one to use.

7. The Data Set Chooser actor will be highlighted next and will display a “Select Datasets” window (see Figure 3.3) that lists the datasets along with the values of a selection of useful header keywords. The first column consists of a set of tick boxes which allow the user to select the datasets to be processed. By default all complete datasets which have not yet been reduced will be selected. A full description of the options offered by the Data Set Chooser will be presented in Section 6.3.2.

8. Click the Continue button and watch the progress of the workflow by following the red highlighting of the actors. A window will show which dataset is currently being processed.

9. Once the reduction of all datasets has finished, a pop-up window called Product Explorer will appear, showing the datasets which have been reduced together with the list of final products. This actor allows the user to inspect the final data products, as well as to search and inspect the input data used to create any of the products of the workflow. Figure 3.5 shows the Product Explorer window. A full description of the Product Explorer will be presented in Section 6.3.3.

10. After the workflow has finished, all the products from all the datasets can be found in a directory under END_PRODUCTS_DIR named after the workflow start timestamp. Further subdirectories will be found with the name of each dataset.

Well done! You have successfully completed the quick start section and you should be able to use this knowledge to reduce your own data. However, there are many interesting features of Reflex and the VIMOS workflow that merit a look at the rest of this tutorial.

Figure 3.1: The empty Reflex canvas.

---

3The keywords listed can be changed by double clicking on the DataOrganiser Actor and editing the list of keywords in the second line of the pop-up window. Alternatively, instead of double-clicking, you can press the right mouse button on the DataOrganiser Actor and select Configure Actor to visualize the pop-up window.
Figure 3.2: VIMOS/MOS workflow general layout.

Figure 3.3: The “Select Datasets” pop-up window.
**Figure 3.4:** The interactive window of the `vmmoscalib` actor for the first demo Dataset.

**Figure 3.5:** The Product Explorer shows all datasets reduced in previous executions together with the full reduction chain for all the pipeline products.
4 About the main esoreflex canvas

4.1 Saving And Loading Workflows

In the course of your data reductions, it is likely that you will customise the workflow for various data sets, even if this simply consists of editing the ROOT_DATA_DIR to a different value for each data set. Whenever you modify a workflow in any way, you have the option of saving the modified version to an XML file using File -> Export As (which will also open a new workflow canvas corresponding to the saved file). The saved workflow may be opened in subsequent esoreflex sessions using File -> Open. Saving the workflow in the default Kepler format (.kar) is only advised if you do not plan to use the workflow with another computer.

4.2 Buttons

At the top of the esoreflex canvas are a set of buttons which have the following functions:

- [Zoom in]
- [Reset the zoom to 100%]
- [Zoom the workflow to fit the current window size (Recommended)]
- [Zoom out]
- [Run (or resume) the workflow]
- [Pause the workflow execution]
- [Stop the workflow execution]

The remainder of the buttons (not shown here) are not relevant to the workflow execution.

4.3 Workflow States

A workflow may only be in one of three states: executing, paused, or stopped. These states are indicated by the yellow highlighting of the [Run], [Pause], and [Stop] buttons, respectively. A workflow is executed by clicking the [Run] button. Subsequently the workflow and any running pipeline recipe may be stopped immediately by clicking the [Stop] button, or the workflow may be paused by clicking the [Pause] button which will allow the current actor/recipe to finish execution before the workflow is actually paused. After pausing, the workflow may be resumed by clicking the [Run] button again.
5 The VIMOS Workflow

The VIMOS workflow canvas is organised into a number of areas. From top-left to top-right you will find general workflow instructions, directory parameters, and global parameters. In the middle row you will find five boxes describing the workflow general processing steps in order from left to right, and below this the workflow actors themselves are organised following the workflow general steps.

5.1 Workflow Canvas Parameters

The workflow canvas displays a number of parameters that may be set by the user. Under “Setup Directories” the user is only required to set the RAW_DATA_DIR to the working directory for the dataset(s) to be reduced, which, by default, is set to the directory containing the demo data. The RAW_DATA_DIR is recursively scanned by the Data Organiser actor for input raw data. The directory CALIB_DATA_DIR, which is by default within the pipeline installation directory, is also scanned by the Data Organiser actor to find any static calibrations that may be missing in your dataset(s). If required, the user may edit the directories BOOKKEEPING_DIR, LOGS_DIR, TMP_PRODUCTS_DIR, and END_PRODUCTS_DIR, which correspond to the directories where book-keeping files, logs, temporary products and end products are stored, respectively (see the Reflex User Manual for further details; Forchi (2012)).

There is a mode of the Data Organiser that skips the built-in data organisation and uses instead the data organisation provided by the CalSelector tool. To use this mode, click on Use CalSelector associations in the Data Organiser properties and make sure that the input data directory contains the XML file downloaded with the CalSelector archive request (note that this does not work for all instrument workflows).

Under the “Global Parameters” area of the workflow canvas, the user may set the FITS_VIEWER parameter to the command used for running his/her favourite application for inspecting FITS files. Currently this is set by default to fv, but other applications, such as ds9, skycat and gaia for example, may be useful for inspecting image data. Note that it is recommended to specify the full path to the visualization application (an alias will not work).

By default the EraseDirs parameter is set to false, which means that no directories are cleaned before executing the workflow, and the recipe actors will work in Lazy Mode (see Section 5.2.4), reusing the previous pipeline recipe outputs if input files and parameters are the same as for the previous execution, which saves considerable processing time. Sometimes it is desirable to set the EraseDirs parameter to true, which forces the workflow to recursively delete the contents of the directories specified by BOOKKEEPING_DIR, LOGS_DIR, and TMP_PRODUCTS_DIR. This is useful for keeping disk space usage to a minimum and will force the workflow to fully re-reduce the data each time the workflow is run.

The parameter RecipeFailureMode controls the behaviour in case that a recipe fails. If set to Continue, the workflow will trigger the next recipes as usual, but without the output of the failing recipe, which in most of the cases will lead to further failures of other recipes without the user actually being aware of it. This mode might be useful for unattended processing of large number of datasets. If set to Ask, a pop-up window will ask whether the workflow should stop or continue. This is the default. Alternatively, the Stop mode will stop the workflow execution immediately.

The parameter GlobalPlotInteractivity controls whether the interactive windows will appear for those windows which are enabled by default. The possible values are true, false. Take into account that some
windows are disabled in the default configuration and therefore are not affected by this parameter.

The parameter `ProductExplorerMode` controls whether the `ProductExplorer` actor will show its window or not. The possible values are `Enabled`, `Triggered`, and `Disabled`. `Enabled` opens the `ProductExplorer` GUI at the end of the reduction of each individual dataset. `Triggered` (default and recommended) opens the `ProductExplorer` GUI when all the selected datasets have been reduced. `Disabled` does not display the `ProductExplorer` GUI.

5.2 Workflow Actors

5.2.1 Simple Actors

Simple actors have workflow symbols that consist of a single (rather than multiple) green-blue rectangle. They may also have an icon within the rectangle to aid in their identification. The following actors are simple actors:

- The `DataOrganiser` actor.

- The `DataSetChooser` actor (inside a composite actor).

- The `FitsRouter` actor. Redirects files according to their categories.

- The `ProductRenamer` actor.

- The `ProductExplorer` actor (inside a composite actor).

Access to the parameters for a simple actor is achieved by right-clicking on the actor and selecting `Configure Actor`. This will open an “Edit parameters” window. Note that the `Product Renamer` actor is a jython script (Java implementation of the Python interpreter) meant to be customised by the user (by double-clicking on it).

5.2.2 Composite Actors

Composite Actors have workflow symbols that consist of multiply-layered green-blue rectangles. They generally do not have a logo within the rectangle. A Composite Actor represents a combination of more Simple or Composite Actors which hides over-complexity from the user in the top-level workflow.

Composite Actors may also be expanded for inspection. To do this, right-click on the actor and select `Open Actor`, which will expand the Composite Actor components in a new Reflex canvas window. If the Composite Actor corresponds to a pipeline recipe, then the corresponding `RecipeExecutor` actor will be present.
as a Simple Actor, and its parameters are accessible as for any other Simple Actor. Alternatively you may still find Composite Actors, on which you need to repeat the first step to access the Recipe Executer.

5.2.3 Recipe Execution within Composite Actors

The VIMOS workflow contains Composite Actors to run pipeline recipes. This is in the most simple case due to the SoF Splitter/SoF Accumulator\(^4\), which allow to process calibration data from different setting within one given DataSet (e.g. lamp frames taken with different slits/masks). More complex Composite Actors contain several actors (e.g. Recipe Executer).

![Figure 5.1: This is the window you get when you choose Open Actor for the Composite Actor MasterBias. This is the most simple case for a Composite Actor. Using Configure Actor on vimos_bias_1 gives you Fig. 5.2.](image)

The central elements of any Reflex workflow are the RecipeExecuter actors that actually run the recipes. One basic way to embed a RecipeExecuter in a workflow is shown in Fig 5.1, which is the most simple version of a Composite Actor. The RecipeExecuter is preceded by an SofSplitter, and followed by an SofAccumulator. The function of the SofSplitter is to investigate the incoming SoFs, sort them by “purpose”, and create separate SoFs for each purpose. The RecipeExecuter then processes each of the SoFs independently (unless they are actually the same files). Finally, the SofAccumulator packs all the results into a single output SoF. The direct relation between the SofSplitter and SofAccumulator is used to communicate the number of different SoFs created by the SofSplitter. A workflow will only work as intended if the purpose of all the files a recipe needs as input is identical. The only exception to this rule is that a purpose can also be “default”. In this case, the file is included in any output SoF created by the SofSplitter and SofAccumulator.

The reason for this scheme is best explained by an example. For a complex DataSet, the Data Organiser might have selected a large number of individual raw lamp frames (arc and flat field). The different lamp frames are to be used to calibrate different frames, e.g. the science frames and the standard star frames. The Data Organiser determines and records this “purpose” of each lamp frame, and this information is included in the DataSet and each SoF created from this DataSet. The FitsRouter directs all raw lamp frames to the calibration Composite Actor. The SofSplitter then creates SoFs, one for the lamp frames to be used for the science frames, and (probably) separate ones for the lamp frames to be used for the standard star observations. The calibration recipe creates one master flat field (and other products) for each SoF, and the SofAccumulator then creates a SoF that contains all the products.

\(^4\)SoF stands for Set of Files, which is an ASCII file containing the name (and path) of each input file and its category (e.g. BIAS).
A RecipeExecutor actor is used in the workflow to run a single VIMOS pipeline recipe (e.g.: in the MasterBias actor the recipe vmbias is executed). In order to configure the RecipeExecuters, one has to first use Open Actor to get to the level of the recipe executors (see Fig. 5.1).

![RecipeExecutor configuration window](image)

**Figure 5.2:** The “Edit parameters” window for a typical RecipeExecutor actor, the vmbias_1 actor which runs the vmbias pipeline recipe.

In Figure 5.2 we show the “Edit parameters” window for a typical RecipeExecutor actor, which can be displayed by right-clicking on the actor and selecting Configure Actor. In the following we describe in more detail the function of some of the parameters for a RecipeExecutor actor:

- The “recipe” parameter states the VIMOS pipeline recipe which will be executed.

- The “mode” parameter has a pull-down menu allowing the user to specify the execution mode of the actor. The available options are:
  - Run: The pipeline recipe will be executed, possibly in Lazy mode (see Section 5.2.4). This option is the default option.
  - Skip: The pipeline recipe is not executed, and the actor inputs are passed to the actor outputs.
  - Disabled: The pipeline recipe is not executed, and the actor inputs are not passed to the actor outputs.
Table 5.1: The VIMOS/MOS pipeline actors and their contents

<table>
<thead>
<tr>
<th>actor</th>
<th>recipe</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MasterBias</td>
<td>vmbias</td>
<td>create master bias</td>
</tr>
<tr>
<td>VimosMosCalib</td>
<td>vmmoscalib</td>
<td>create master flat, determine coefficients for wavelength calibration and correction of spatial distortion</td>
</tr>
<tr>
<td>Response Curve</td>
<td>vmmossience</td>
<td>determine response function</td>
</tr>
<tr>
<td>VimosScience</td>
<td>vmmossience</td>
<td>reduce science data</td>
</tr>
</tbody>
</table>

- The “Lazy Mode” parameter has a tick-box (selected by default) which indicates whether the RecipeExecuter actor will run in Lazy mode or not. A full description of Lazy mode is provided in Sect. 5.2.4.

- The “Recipe Failure Mode” parameter has a pull-down menu allowing the user to specify the behaviour of the actor if the pipeline recipe fails. The available options are:
  - **Stop**: The actor issues an error message and the workflow stops.
  - **Continue**: The actor creates an empty output and the workflow continues.
  - **Ask**: The actor displays a pop-up window and asks the user whether he/she wants to continue or stop the workflow. This option is the default option.

- The set of parameters which start with “recipe param” and end with a number or a string correspond to the parameters of the relevant VIMOS pipeline recipe. By default in the RecipeExecuter actor, the pipeline recipe parameters are set to their pipeline default values. If you need to change the default parameter value for any pipeline recipe, then this is where you should edit the value. For more information on the VIMOS pipeline recipe parameters, the user should refer to the VIMOS pipeline user manual (Izzo et al. 2012).

The description of the remainder of the RecipeExecuter actor parameters are outside the scope of this tutorial, and the interested user is referred to the Reflex User Manual for further details (Forchì 2012). Any changes that you make in the “Edit parameters” window must be saved in the workflow by clicking the Commit button when you have finished to take effect. If you want to reuse the parameters you have to save the workflow with the saved parameters.

5.2.4 Lazy Mode

By default, all RecipeExecuter actors in a pipeline workflow are “Lazy Mode” enabled. This means that when the workflow attempts to execute such an actor, the actor will check whether the relevant pipeline recipe has already been executed with the same input files and with the same recipe parameters. If this is the case, then the actor will not execute the pipeline recipe, and instead it will simply broadcast the previously generated products to the output port. The purpose of the Lazy Mode is therefore to minimise any reprocessing of data by avoiding data re-reduction where it is not necessary.

One should note that the actor’s Lazy Mode depends on the contents of the directory specified by the parameter BOOKKEEPING_DIR and the relevant FITS file checksums. Any modification to the directory contents and/or

---

the file checksums will cause the corresponding actor to run the pipeline recipe again when executed, thereby re-reducing the input data.

The re-reduction of data at each execution may sometimes be desirable. To force a re-reduction of data for any single RecipeExecuter actor in the workflow, right-click the actor, select Configure Actor, and uncheck the Lazy mode parameter tick-box in the “Edit parameters” window that is displayed. For many workflows the RecipeExecuter actors are actually found inside the composite actors in the top level workflow. To access such embedded RecipeExecuter actors you will first need to open the sub-workflow by right-clicking on the composite actor and then selecting Open Actor.

To force the re-reduction of all data in a workflow (i.e. to disable Lazy mode for the whole workflow), you must uncheck the Lazy mode for every single RecipeExecuter actor in the entire workflow. It is also possible to change the name of the bookkeeping directory, instead of modifying any of the Lazy mode parameters. This will also force a re-reduction of the given dataset(s). A new reduction will start (with the lazy mode still enabled), but the results of previous reduction will not be reused. Alternatively, if there is no need to keep any of the previously reduced data, one can simply set the EraseDirs parameter under the “Global Parameters” area of the workflow canvas to true. This will then remove all previous results that are stored in the bookkeeping, temporary, and log directories before processing the input data, in effect, starting a new clean data reduction and re-processing every input dataset. Note: The option EraseDirs = true does not work in esoreflex version 2.9.x and makes the workflow to crash.
6 Reducing your own data

In this section we describe how to reduce your own data set.

First, we suggest the reader to familiarize with the workflow by reducing the demo dataset first (Section 3), but it is not a requirement.

6.1 The esoreflex command

We list here some options associated to the esoreflex command. We recommend to try them to familiarize with the system. In the following, we assume the esoreflex executable is in your path; if not you have to provide the full path <install_dir>/bin/esoreflex

To see the available options of the esoreflex command type:

```bash
esoreflex -h
```

The output is the following.

```
-h | -help          print this help message and exit.
-v | -version       show installed Reflex version and pipelines and exit.
-l | -list-workflows list available installed workflows and from
                 ~/KeplerData/workflows.
-n | -non-interactive enable non-interactive features.
-e | -explore        run only the Product Explorer in this workflow
-p <workflow> | -list-parameters <workflow> lists the available parameters for the given workflow.
-config <file>     allows to specify a custom esoreflex.rc configuration file.
-create-config <file> if <file> is TRUE then a new configuration file is
                 created in ~/.esoreflex/esoreflex.rc. Alternatively a
                 configuration file name can be given to write to. Any
                 existing file is backed up to a file with a `.bak`
                 extension, or `.bakN` where N is an integer.
-debug             prints the environment and actual Reflex launch command used.
```

6.2 Launching the workflow

We list here the recommended way to reduce your own datasets. Steps 1 and 2 are optional and one can start from step 3.

1. Type: `esoreflex -n <parameters>` VIMOS MOS to launch the workflow non interactively and reduce all the datasets with default parameters.
<parameters> allows you to specify the workflow parameters, such as the location of your raw data and the final destination of the products.

For example, type (in a single command line):

```bash
esoreflex -n
-RAW_DATA_DIR /home/user/my_raw_data
-ROOT_DATA_DIR /home/user/my_reduction
-END_PRODUCTS_DIR $ROOT_DATA_DIR/reflex_end_products
vimos_mos
```

to reduce the complete datasets that are present in the directory /home/user/my_raw_data and that were not reduced before. Final products will be saved in /home/user/my_reduction/reflex_end_products, while book keeping, temporary products, and logs will be saved in sub-directories of /home/user/my_reduction/. If the reduction of a dataset fails, the reduction continues to the next dataset. It can take some time, depending on the number of datasets present in the input directory. For a full list of workflow parameters type esoreflex -p VIMOS MOS. Note that this command lists only the parameters, but does not launch the workflow.

Once the reduction is completed, one can proceed with optimizing the results with the next steps.

2. Type:

```bash
esoreflex -e vimos_mos
```

to launch the Product Explorer. The Product Explorer allows you to inspect the data products already reduced by the VIMOS MOS esoreflex workflow. Only products associated with the workflow default bookkeeping database are shown. To visualize products associated to given bookkeeping database, pass the full path via the BOOKKEEPING_DB parameter:

```bash
esoreflex -e BOOKKEEPING_DB <database_path> vimos_mos
```

to point the product explorer to a given <database_path>, e.g., /home/username/reflex/reflex_bookkeeping/test.db

The Product Explorer allows you to inspect the products while the reduction is running. Press the button Refresh to update the content of the Product Explorer. This step can be launched in parallel to step 1.

A full description of the Product Explorer will be given in Section 6.3.3

3. Type:

```bash
esoreflex vimos_mos &
```

to launch the VIMOS MOS esoreflex workflow. The VIMOS MOS workflow window will appear (Fig. 3.2). Please configure the set-up directories ROOT_DATA_DIR, RAW_DATA_DIR, and other workflow parameters as needed. Just double-click on them, edit the content, and press OK. Remember to specify the same <database_path> as for the Product Explorer, if it has been opened at step #2, to synchronize the two processes.

4. (Recommended, but not mandatory) On the main esoreflex menu set Tools -> Animate at Runtime to 1 in order to highlight in red active actors during execution.

5. Press the button ``` to start the workflow. First, the workflow will highlight and execute the Initialise actor, which among other things will clear any previous reductions if required by the user (see Section 5.1).
Secondly, if set, the workflow will open the Product Explorer, allowing the user to inspect previously reduced datasets (see Section 6.3.3 for how to configure this option).

Figure 6.1: The “Select Frames” window with a single file from the current Data Set highlighted in blue, and the corresponding FITS header displayed in the text box on the right. Hidden partially behind the “Select Frames” window is the “Select DataSets” window with the currently selected DataSet highlighted in blue.

6.3 Workflow Steps

6.3.1 Data Organisation And Selection

The DataOrganiser (DO) is the first crucial component of a Reflex workflow. The DO takes as input RAW_DATA_DIR and CALIB_DATA_DIR and it detects, classifies, and organises the files in these directories and any subdirectories. The output of the DO is a list of “DataSets”. A DataSet is a special Set of Files (SoF). A DataSet contains one or several science (or calibration) files that should be processed together, and all files needed to process these data. This includes any calibration files, and in turn files that are needed to process
these calibrations. Note that different DataSets might overlap, i.e. some files might be included in more than one DataSet (e.g., common calibration files).

A DataSet lists three different pieces of information for each of its files, namely 1) the file name (including the path), 2) the file category, and 3) a string that is called the “purpose” of the file. The DO uses the OCA\(^6\) rules to find the files to include in a DataSet, as well as their categories and purposes. The file category identifies different types of files, and it is derived by information in the header of the file itself. A category could for example be RAW_CALIBRATION_1, RAW_CALIBRATION_2 or RAW_SCIENCE, depending on the instrument. The purpose of a file identifies the reason why a file is included in a DataSet. The syntax is action_1/action_2/action_3/ ... /action_n, where each action_i describes an intended processing step for this file (for example, creation of a MASTER_CALIBRATION_1 or a MASTER_CALIBRATION_2).

The actions are defined in the OCA rules and contain the recipe together with all file categories required to execute it (and predicted products in case of calibration data). For example, a workflow might include two actions action_1 and action_2. The former creates MASTER_CALIBRATION_1 from RAW_CALIBRATION_1, and the later creates a MASTER_CALIBRATION_2 from RAW_CALIBRATION_2. The action_2 action needs RAW_CALIBRATION_2 frames and the MASTER_CALIBRATION_1 as input. In this case, these RAW_CALIBRATION_1 files will have the purpose action_1/action_2. The same DataSet might also include RAW_CALIBRATION_1 with a different purpose; irrespective of their purpose the file category for all these biases will be RAW_CALIBRATION_1.

The DataSets created via the DataOrganiser will be displayed in the DataSet Chooser. Here the users have the possibility to inspect the various datasets and decide which one to reduce. By default, DataSets that have not been reduced before are highlighted for reduction. Click either [Continue] in order to continue with the workflow reduction, or [Stop] in order to stop the workflow. A full description of the DataSet Chooser is presented in Section 6.3.2.

Once the [Continue] is pressed, the workflow starts to reduce the first selected DataSet. Files are broadcasted according to their purpose to the relevant actors for processing.

The categories and purposes of raw files are set by the DO, whereas the categories and purpose of products generated by recipes are set by the RecipeExecutor. The file categories are used by the FitsRouter to send files to particular processing steps or branches of the workflow (see below). The purpose is used by the SofSplitter and SofAccumulator to generate input SoFs for the RecipeExecutor. The SofSplitter and SofAccumulator accept several SoFs as simultaneous input. The SofAccumulator creates a single output SoF from the inputs, whereas the SofSplitter creates a separate output SoF for each purpose.

\(^6\)OCA stands for OrganisationClassificationAssociation and refers to rules, which allow to classify the raw data according to the contents of the header keywords, organise them in appropriate groups for processing, and associate the required calibration data for processing. They can be found in the directory <install_dir>/share/esopipes/<pipeline-version>/reflex/, carrying the extension .oca. The variable <install_dir> depends on the operative system and installation procedure. For installation through rpm: <install_dir>=/usr; for installation through macport <install_dir>=/opt/local; for installation through the installation script install_esoreflex it depends on the path specified during installation, e.g. <install_dir>=<specified_path>/install
6.3.2 dataSetChooser

The dataSetChooser displays the dataSets available in the “Select Data Sets” window, activating vertical and horizontal scroll bars if necessary (Fig. 3.3).

Some properties of the dataSets are displayed: the name, the number of files, a flag indicating if it has been successfully reduced (a green OK), if the reduction attempts have failed or were aborted (a red FAILED), or if it is a new dataset (a black "."). The column “Descriptions” lists user-provided descriptions (see below), other columns indicate the instrument set-up and a link to the night log.

Sometimes you will want to reduce a subset of these dataSets rather than all dataSets, and for this you may individually select (or de-select) dataSets for processing using the tick boxes in the first column, and the buttons [Deselect All] and [Select Complete] at the bottom, or configure the “Filter” field at the bottom left. Available filter options are: "New" (datasets not previously reduced will be selected), "Reduced" (datasets previously reduced will be selected), "All" (all datasets will be selected), and "Failed" (dataset with a failed or aborted reduction will be selected).

You may also highlight a single DataSet in blue by clicking on the relevant line. If you subsequently click on [Inspect Highlighted], then a “Select Frames” window will appear that lists the set of files that make up the highlighted DataSet including the full filename\(^7\), the file category (derived from the FITS header), and a selection tick box in the right column. The tick boxes allow you to edit the set of files in the DataSet which is useful if it is known that a certain calibration frame is of poor quality (e.g: a poor raw flat-field frame). The list of files in the DataSet may also be saved to disk as an ASCII file by clicking on [Save As] and using the file browser that appears.

By clicking on the line corresponding to a particular file in the “Select Frames” window, the file will be highlighted in blue, and the file FITS header will be displayed in the text box on the right, allowing a quick inspection of useful header keywords. If you then click on [Inspect] the workflow will open the file in the selected FITS viewer application defined by the workflow parameter [FITS_VIEWER].

To exit from the “Select Frames” window, click [Continue].

To add a description of the reduction, press the button [....] associated with the field "Add description to the current execution of the workflow" at the bottom right of the Select DataSet Window; a pop up window will appear. Enter the desired description (e.g. "My first reduction attempt") and then press [OK]. In this way, all the datasets reduced in this execution, will be flagged with the input description. Description flags can be visualized in the SelectFrames window and in the ProductExplorer, and they can be used to identify different reduction strategies.

To exit from the “Select DataSets” window, click either [Continue] in order to continue with the workflow reduction, or [Stop] in order to stop the workflow.

6.3.3 The ProductExplorer

The ProductExplorer is an interactive component in the esoreflex workflow whose main purpose is to list the final products with the associated reduction tree for each dataset and for each reduction attempt (see Fig. 3.5).
Configuring the ProductExplorer

You can configure the ProductExplorer GUI to appear after or before the data reduction. In the latter case you can inspect products as reduction goes on.

1. To display the ProductExplorer GUI at the end of the data reduction:

   • Click on the global parameter “ProductExplorerMode” before starting the data reduction. A configuration window will appear allowing you to set the execution mode of the Product Explorer. Valid options are:
     - "Triggered" (default). This option opens the ProductExplorer GUI when all the selected datasets have been reduced.
     - "Enabled". This option opens the ProductExplorer GUI at the end of the reduction of each individual dataset.
     - “Disable”. This option does not display the ProductExplorer GUI.

   • Press the button to start the workflow.

2. To display the ProductExplorer GUI “before” starting the data reduction:

   • double click on the composite Actor "Inspect previously reduced data". A configuration window will appear. Set to “Yes” the field "Inspect previously reduced data? (Yes/No)". Modify the field "Continue reduction after having inspected the previously reduced data? (Continue/Stop/Ask)". "Continue" will continue the workflow and trigger the DataOrganizer. "Stop" will stop the workflow; "Ask" will prompt another window deferring the decision whether continuing or not the reduction after having closed the Product Explorer.

   • Press the button to start the workflow. Now the ProductExplorer GUI will appear before starting the data organization and reduction.

Exploring the data reduction products

The left window of the ProductExplorer GUI shows the executions for all the datasets (see Fig. 3.5). Once you click on a dataset, you get the list of reduction attempts. Green and red flags identify successful or unsuccessful reductions. Each reduction is linked to the “Description” tag assigned in the “Select Dataset” window.

1. To identify the desired reduction run via the “Description” tag, proceed as follows:

   • Click on the symbol at the left of the dataset name. The full list of reduction attempts for that dataset will be listed. The column Exec indicates if the reduction was successful (green flag: "OK") or not (red flag: "Failed").

   • Click on the entries in the field "Description" to visualize the description you have entered associated to that dataset on the Select Dataset window when reducing the data.
• Identify the desired reduction run. All the products are listed in the central window, and they are organized following the data reduction cascade.

You can narrow down the range of datasets to search by configuring the field "Show" at the top-left side of the ProductExplorer (options are: "All", "Successful", "Unsuccessful"), and specifying the time range (Last, all, From-to).

2. To inspect the desired file, proceed as follows:

• Navigate through the data reduction cascade in the ProductExplorer by clicking on the files.

• Select the file to be inspected and click with the mouse right-hand button. The available options are:

  – Options available always:
    * Copy full path. It copies the full name of the file onto the clipboard. Shift+Ctrl+v to paste it into a terminal.
    * Inspect Generic. It opens the file with the fits viewer selected in the main workflow canvas.
    * Inspect with. It opens the file with an executable that can be specified (you have to provide the full path to the executable).

  – Options available for files in the TMP_PRODUCTS_DIR directory only:
    * command line. Copy of the environment configuration and recipe call used to generate that file.
    * Xterm. It opens an Xterm at the directory containing the file.

  – Options available for products associated to interactive windows only:
    * Display pipeline results. It opens the interactive windows associated to the recipe call that generated the file. Note that this is for visualization purposes only; the recipe parameters cannot be changed and the recipe cannot be re-run from this window.

6.3.4 Creation Of Master Calibration Files

In this step of the workflow, the following VIMOS recipes are executed in the order listed below. Please refer to the VIMOS pipeline user manual (Izzo et al. 2012: Sections 9 and 10) for the details of each recipe and the algorithms employed:

1. The MasterBias actor will execute the VIMOS pipeline recipe vmbias in order to create a combined master bias frame from the set of raw bias frames

2. The VimosMosCalib actor will execute the VIMOS pipeline recipe vmmoscalib in order to create from the set of raw flat and arc frames a combined master flat frame as well as coefficients for wavelength calibration and correction of spatial distortions.
6.3.5 Response Computation

In this step of the workflow, the ResponseCurve actor will determine the response function (if a flux standard star is provided) using the recipe vmmossscience, which will subsequently be used to flux-calibrate the science observation. Please refer to the VIMOS pipeline user manual (Izzo et al. 2012: Sections 9 and 10) for the details of this recipe.

Note that this actor will be skipped if there are no observations of a standard star in the current DataSet. A standard star observation is only included in the DataSet for a science observation if it was taken within ±7 nights of the science observation. For some combinations of grism and filter, VIMOS PI-Packs as well as CalSelector data sets are supplied with master instrument response curves. These are currently not included in the data set for a science observation.

6.3.6 Science Reduction

The VimosScience actor will execute the VIMOS pipeline recipe vmmossscience to apply sky subtraction and extract the spectra. Please refer to the VIMOS pipeline user manual (Izzo et al. 2012: Sections 9 and 10) for the details of this recipe and the extraction algorithms employed. The VIMOS/MOS workflow will flux-calibrate the science observation using the instrument response curve derived from the standard star observation if it exists in the current DataSet. If no standard star observation exists in the current DataSet, then the science observation will not be flux-calibrated.

6.3.7 Output Organisation

After having processed the input data for a DataSet, the Data Filter actor allows the user to inspect the results and select which files to save. By default this actor is set to skip and all products will be saved. Next the workflow highlights and executes the Product Renamer actor, which, by default, will copy the defined final products of the VimosScience actor to the directory specified by END_PRODUCTS_DIR and rename them with names derived from the values of certain FITS header keywords. Specifically, final products are renamed by default with names of the form <HIERARCH.ESO.OBS.NAME>_<HIERARCH.ESO.PRO.CATG>.fits, where <HIERARCH.ESO.OBS.NAME> and <HIERARCH.ESO.PRO.CATG> represent the values of the corresponding FITS header keywords (<HIERARCH.ESO.OBS.NAME> is the name of the OB and <HIERARCH.ESO.PRO.CATG> is the category of the product file). These names are fully configurable by right-clicking on the Product Renamer actor, selecting Configure Actor, and then editing the string as appropriate. In some cases the keyword <HIERARCH.ESO.OBS.TARG.NAME> (target name) may be more useful than <HIERARCH.ESO.OBS.NAME>.

The final products that are copied and renamed are (for better readability we replace <HIERARCH.ESO.OBS.NAME> by <OB_NAME>):

• **1-dimensional extracted spectra** (<OB_NAME>_REDUCED_*>, created only if spectra are identified and can be extracted).

The individual spectra are provided as rows in a FITS file. The correspondence between these rows and the
2-dimensional frames and/or slit identifications can be obtained from `<OB_NAME>_OBJECT_SCI_TABLE.fits`. All extracted spectra have the same format.

- `<OB_NAME>_MOS_SCIENCE_REduced.fits` spectra
- `<OB_NAME>_MOS_SCI_ERROR_REduced.fits` errors on spectra
- `<OB_NAME>_MOS_SCI_SKY_REduced.fits` sky spectra
- `<OB_NAME>_MOS_SCIENCE_FLUX_REduced.fits` flux-calibrated spectra
- `<OB_NAME>_MOS_SCI_ERROR_FLUX_REduced.fits` error of flux-calibrated spectra

• 2-dimensional wavelength calibrated and distortion corrected frames (`<OB_NAME>_EXTRACTED_*`)

- `<OB_NAME>_MOS_SCIENCE_EXTRACTED.fits` 2-dimensional SCIENCE frame, sky-subtracted
- `<OB_NAME>_MOS_SCIENCE_SKY_EXTRACTED.fits` 2-dimensional SCIENCE frame without sky subtraction
- `<OB_NAME>_MOS_SCIENCE_FLUX_EXTRACTED.fits` 2-dimensional SCIENCE frame, sky-subtracted and flux-calibrated
- `<OB_NAME>_MOS_SCIENCE_SKY.fits` 2-dimensional frame with fitted sky background

• `<OB_NAME>_OBJECT_SCI_TABLE.fits` Positions of detected objects

• `<OB_NAME>_MOS_SCI_DISP_COEFF_SKY.fits` dispersion coefficients after adjusting to sky line positions

All products `<HIERARCH.ESO.OBS.NAME>_type_FLUX` are created only if flux standard star observations are provided and the standard star flux table is available (`type` being `REDUCED` or `EXTRACTED`).

If `sky alignment` is requested (`skyalign>=0`) then the shifts in wavelength derived from sky line positions will be provided in `<OB_NAME>_MOS_SCI_SKYLINES_OFFSETS_SLIT.fits` as an extra product.

If only a single frame was processed then `<OB_NAME>_MOS_UNMAPPED_SCIENCE_ERR.fits`, being the errors on sky subtracted scientific spectra unrectified, will also be provided.

And finally, if `sky alignment` and a only single file was processed, then the 2-dimensional frame with pixel value= wavelength of pixel, will be provided in `<OB_NAME>_MOS_SCI_WAVELENGTH_MAP_SKY.fits`.

The remaining actors in this step of the workflow are concerned with the termination of the data flow for the current DataSet and will highlight briefly as they are executed.

### 6.4 Interactive Windows

The VIMOS MOS workflow contains three interactive windows that allow the user to iterate on the processing of their data. They are described below.
6.4.1 vmmoscalib

The interactive window shown in Fig. 3.4 (p. 14) provides information about the quality of the wavelength calibration (left column), distortion correction (top right and center plot) and the flat field combination and normalization (bottom right plot). The plots contain in detail:

**Top Left  Wavelength map** The wavelength map has as pixel values the wavelength of a pixel. All slitlets should be present, the regions of the slitlets should not be strongly curved nor should regions of different slitlets overlap with each other.

**Top Center  First raw flat** This plot is mostly of interest in comparison to the **Top Right** and **Top Left** one, as the number of slitlets and the areas covered by them should be identical.

**Top Right  Normalized master flat** The normalized master flat field should have the same number of slitlets as the first raw flat and their areas should also be identical. The red lines show the traces of the slitlet edges. They should therefore follow the slit edges and not cut across slitlets. All slitlets should be detected and there should be no spurious detections (e.g. one slitlet detected as several).

**Center Left  Residuals between predicted and detected arc line position** The residuals should generally be below 0.5 pixel. If they show systematic variations the polynomial degree used to fit the dispersion relation may be too low (or in rare cases too high). If the scatter appears very large one should zoom in, because there are often only a few outliers and the majority of the residuals are within ±0.5 pixels. Middle-clicking with the mouse on a line will add the catalogue line nearest to this position to -ignore_lines. Doing this again after re-running the recipe, however, will overwrite previously ignored lines.

**Center Right** Detected (black), identified (green) and rejected lines (red). If you see a large number of rejected lines zoom in to verify that this is really a problem. The limited plot size can give a wrong impression.

**Bottom  Wavelength-calibrated arc lamp frame** In this plot the arc lamp lines should run straight from top to bottom without any empty rows between them. Some arc lines may show gaps due to the placement of the slits, but empty rows without any lines point towards problems with the detection of the arc lamp lines.

The buttons in the **bottom right** window allow to switch between extensions for multiplexed data. For multiplex data one should always verify the results for all extensions, as parameters which improve some extension may give worse results for others.

6.4.2 vmmosscience (Response)

The interactive window shown in Fig. 6.2 provides information about the quality of the response curve fit:

**Top  Extracted standard star spectrum** The extracted standard star spectrum should shows no jumps or sky emission lines. Strong gradients due to order separating filters are valid but may cause problems with the fit of the response curve.

**Center  Raw response and fit** The dots show the raw response (ratio of reference spectrum and observed spectrum integrated over same bins as reference spectrum) and the blue line shows the corresponding fit. Blue dots are masked (ignore_resp_mode, ignore_resp_points) and not used for the fit.
Figure 6.2: The interactive window of the ResponseCurve actor for the first demo DataSet.

**Bottom Flux-calibrated standard star spectrum and reference:** The red line marks the observed standard star spectrum calibrated with its own response curve and the green and blue points indicate the reference data (blue points were masked during the fitting of the response). Differences between the green points and the red line indicate a problem with the flux calibration, usually features on a scale smaller than the bins of the reference data. Differences between the red line and blue points indicate problems with inter- and/or extrapolation.

The buttons in the **bottom right** window allow to switch between extensions for multiplexed data.

### 6.4.3 vmmoscience (Science)

The interactive window shown in Fig. 6.3 provides information about the quality of the sky subtraction and spectrum extraction. It shows the spectra in ADU/sec, i.e. not flux-calibrated:
**Figure 6.3:** The interactive window of the VimosScience actor for the first demo DataSet.

**Top**  *Mapped sky-subtracted 2-dimensional spectrum:* The wavelength-calibrated, rectified frame is shown after sky subtraction. The yellow and red lines mark the lower/upper extraction limits of the detected spectra. Right-clicking on such a range will plot the extracted spectrum in the **Bottom** plot.

**Bottom**  *Extracted science spectrum:* The spectrum should not show strong residuals of sky lines.

The buttons in the **bottom right** window allow to switch between extensions for multiplexed data.
7 Improving Your Results Through Workflow Interaction

In this section we provide information on how to improve your results by changing the parameters of the `vmmoscalib` and `vmmossscience` recipes.

7.1 Demo Data

**DataSet 1** The interactive window for the wavelength calibration of the science shows quite a few rejected lines (red dots in center right window) and a large scatter in the residuals at the blue end (center left window). This can be improved by setting `wradius` to 0, i.e. switching off the iteration of the wavelength fit.

The response curve ends in a masked telluric region. In order to avoid extrapolation the response is only fit between the bluest and the reddest unmasked points. To see the effect of the masking you can change `resp_ignore_mode` from `stellar_absorption,telluric,command_line` to `stellar_absorption,command_line` and rerun the recipe. Now the fit is less good because more (and deviating) points need to be fit, so the fit parameters need to be changed as well. The feature between 5650 Å and 6150 Å is an instrumental feature, that is corrected by the use of the flat field SED.

**DataSet 2** The wavelength calibration of the flux standard shows some distortions in the wavelength calibrated arc frame. This can be improved by setting `wreject=0.7`.

The spectrum of the flux standard star is shifted by 90 Å, relative to the tabulated values. Setting `resp_shift` to −90 corrects this offset.

7.2 Wavelength Calibration

For multiplex data one should always verify the results for all extensions, as parameters which improve some extension may give worse results for others.

Failures for the various grisms can be recovered in many cases by the following parameter changes:

- **LR_blue** increase `peakdetection` to 100 (for failure during slit identification)
- **LR_red** reduce `wreject` to 0.4
- **HR_blue** reduce `peakdetection` to 30 and/or increase `wreject` to 2.5
- **HR_orange** reduce `wreject` to 0.4 and/or reduce `peakdetection` to 30
- **HR_red** decrease `wddegree` to 4 (reducing `wreject` to 0.7 or `peakdetection` to 2500 is also sometimes helpful)
8 Frequently Asked Questions

• The error window fills the whole screen - how can I get to the Continue/Stop buttons?
  Press the Alt key together with your left mouse button to move the window upwards and to the left. At
the bottom the Continue/Stop buttons will be visible. This bug is known but could not yet be fixed.

• I tried to Open (or Configure) an Actor while the workflow is running and now it does not react
  any more. What should I do?
  This is a limitation of the underlying Kepler engine. The only way out is to kill the workflow externally.
  If you want to change anything while a workflow is running you first need to pause it.

• After a successful reduction of a data set, I changed this data set in some way (e.g. modified or
  removed some files, or changed the rules of the Data Organizer). When I restart Reflex, the Data
  Set Chooser correctly displays my new data set, but marks it as “reduced ok”, even though it was
  never reduced before. What does this mean?
  The labels in the column “Reduced” of the Data Set Chooser mark each dataset with “OK”, “Failed” or
  “.”. These labels indicate whether a data set has previously successfully been reduced at least once, all
  previous reductions failed, or a reduction has never been tried respectively. Data sets are identified by
  their name, which is derived from the first science file within the data set. As long as the data set name is
  preserved (i.e. the first science file in a data set has not changed), the Data Organizer will consider it to
  be the same data set. The Data Organizer recognizes any previous reductions of data sets it considers to
  be the same as the current one, and labels the current data set with “OK” if any of them was successful,
  even if the previously reduced data set differs from the current one.
  Note that the Product Explorer will list all the previous reductions of a particular data set only at the
  end of the reduction. This list might include successful and/or unsuccessful reduction runs with different
  parameters, or in your case with different input files. The important fact is that these are all reductions
  of data sets with the same first raw science file. By browsing through all reductions of a particular raw
  science file, the users can choose the one they want to use.

• Where are my intermediate pipeline products? Intermediate pipeline products are stored in the direc-
  tory <TMP_PRODUCTS_DIR> (defined on the workflow canvas, under Setup Directories) and organised
  further in directories by pipeline recipe.

• Can I use different sets of bias frames to calibrate my flat frames and science data? Yes. In fact this
  is what is currently implemented in the workflow(s). Each file in a DataSet has a purpose attached to it
  (Forchi (2012)). It is this purpose that is used by the workflow to send the correct set of bias frames to the
  recipes for flat frame combination and science frame reduction, which may or may not be the same set of
  bias frames in each case.

• Can I run Reflex from the command line? Yes, use the command:
  esoreflex -n <workflow_path>/<workflow>.xml
  The -n option will set all the different options for Kepler and the workflows to avoid opening any GUI
  elements (including pipeline interactive windows).
  It is possible to specify workflow variables (those that appear in the workflow canvas) in the command
  line. For instance, the raw data directory can be set with this command:
esoreflex -n -RAW_DATA_DIR <raw_data_path> \
<workflow_path>/<workflow>.xml

You can see all the command line options with the command esoreflex -h.

Note that this mode is not fully supported, and the user should be aware that the path to the workflow must be absolute and even if no GUI elements are shown, it still requires a connection to the window manager.

**How can I add new actors to an existing workflow?** You can drag and drop the actors in the menu on the left of the Reflex canvas. Under Eso-reflex → Workflow you may find all the actors relevant for pipeline workflows, with the exception of the recipe executer. This actor must be manually instantiated using Tools → Instantiate Component. Fill in the “Class name” field with org.eso.RecipeExecuter and in the pop-up window choose the required recipe from the pull-down menu. To connect the ports of the actor, click on the source port, holding down the left mouse button, and release the mouse button over the destination port. Please consult the Reflex User Manual (Forchi (2012)) for more information.

**How can I broadcast a result to different subsequent actors?** If the output port is a multi-port (filled in white), then you may have several relations from the port. However, if the port is a single port (filled in black), then you may use the black diamond from the toolbar. Make a relation from the output port to the diamond. Then make relations from the input ports to the diamond. Please note that you cannot click to start a relation from the diamond itself. Please consult the Reflex User Manual (Forchi (2012)) for more information.

**How can I manually run the recipes executed by Reflex?** If a user wants to re-run a recipe on the command line he/she has to go to the appropriate reflex_book_keeping directory, which is generally reflex_book_keeping/<workflow>/<recipe_name>_<number> There, subdirectories exist with the time stamp of the recipe execution (e.g. 2013-01-25T12:33:53.926/). If the user wants to re-execute the most recent processing he/she should go to the latest directory and then execute the script cmdline.sh. Alternatively, to use a customized esorex command the user can execute

```
ESOREX_CONFIG="INSTALL_DIR/etc/esorex.rc"
PATH_TO/esorex --recipe-config=<recipe>.rc <recipe> data.sof
```

where INSTALL_DIR is the directory where Reflex and the pipelines were installed.

If a user wants to re-execute on the command line a recipe that used a specific raw frame, the way to find the proper data.sof in the bookkeeping directory is via grep <raw_file> */data.sof. Afterwards the procedure is the same as before.

If a recipe is re-executed with the command explained above, the products will appear in the directory from which the recipe is called, and not in the reflex_tmp_products or reflex_end_products directory, and they will not be renamed. This does not happen if you use the cmdline.sh script.

**If I enter “-” into an empty integer parameter of an interactive window it is automatically completed to “-1”. Why?**

The parameters are validated for correctness according to their type (e.g. string, integer, float). In the case of an integer or float parameter “-” alone is considered an invalid input and is therefore automatically completed to “-1”. This is part of the validation of input done by the WxPython library.
• Can I reuse the bookkeeping directory created by previous versions of the pipeline?

In general no. In principle, it could be reused if no major changes were made to the pipeline. However there are situations in which a previously created bookkeeping directory will cause problems due to pipeline versions incompatibility. This is especially true if the parameters of the pipeline recipes have changed. In that case, please remove the bookkeeping directory completely.

• How to insert negative values into a textbox?

Due to a bug in wxPython, the GUI might appear to freeze when attempting to enter a negative number in a parameter's value textbox. This can be worked around by navigating away to a different control in the GUI with a mouse click, and then navigating back to the original textbox. Once focus is back on the original textbox the contents should be selected and it should be possible to replace it with a valid value, by typing it in and pressing the enter key.

• I’ve updated my Reflex installation and when I run esoreflex the process aborts. How can I fix this problem?

As indicated in Section 2, in case of major or minor (affecting the first two digit numbers) Reflex upgrades, the user should erase the $HOME/KeplerData, $HOME/.kepler directories if present, to prevent possible aborts (i.e. a hard crash) of the esoreflex process.

• How can I include my analysis scripts and algorithms into the workflow?

EsoReflex is capable of executing any user-provided script, if properly interfaced. The most convenient way to do it is through the Python actor. Please consult the tutorial on how to insert Python scripts into a workflow available here: www.eso.org/sci/data-processing/Python_and_esoreflex.pdf

8.1 VIMOS specific questions

• If I click on "Use the parameters above as initial values in subsequent executions of this recipe", some changes are ignored

The VIMOS pipeline has a special way to handle the parameters which are in the configuration tables. Basically, the initial values are always taken from the configuration table. Still, during the loop execution, the parameters can be changed to the desired values.

If you want to use different values as "initial values" for those parameters, edit the configuration tables (VIMOS_GRS_* to create your own version. The parameters affected are: dispersion, peakdetection, wdegree, cdegree, reference, startwavelength, endwavelength, resp_use_flat_sed, resp_fit_degree, and resp_fit_nknots.

• Can I use the .xml file that is produced by CalSelector as an input of the DO?

Currently no. As of current release the static calibrations in the ESO archive are not compatible with the pipeline. Therefore one has to use the static calibrations installed along with the pipelines. The .xml file produced by CalSelector contains only static calibrations from the archive, making the pipeline fail. This will be fixed in next releases, once the ESO archive has been updated with all the new calibrations.
• **I see small dark and bright regions in my normalized flat field - why?**

These features are caused by stray light from 0\textsuperscript{th} order light in adjacent slitlets. By default the pipeline normalizes the flat fields only along the dispersion axis using a flat field “spectrum” collapsed along the slit. The slit illumination instead is kept \(s\text{radius} = -1\), so that it is present to correct the slit illumination of the science data.

If an adjacent slit has its 0\textsuperscript{th} order within the valid wavelength range of the slit being normalized, the stray light from this 0\textsuperscript{th} order peak creates a strong local gradient in the flat field of the slit being normalized. The collapsed flat field "spectrum" contains an averaged value of this gradient, which then creates a hole/peak combination in the normalized flat field. This in turn creates a peak/hole combination in the flat-fielded science data.

The science data will also be contaminated by the 0\textsuperscript{th} order light, but in a different way as the flat field spectra are all from one source while the science spectra are created by different sources.

This effect can be reduced by setting \(s\text{radius} > 0\). In this case the spatial profile is determined by smoothing along the slit, row by row, which corrects most of the effect, but also removes the general slit illumination profile.

• **I am using the maximum number of knots for the spline fit of the response but the fit still does not go through all data points.**

The maximum number of knots for the spline is the number of unmasked data points – 2 (entering a higher number will cause the pipeline to reduce it to the allowed maximum). Since the knots are distributed at equal distances this means that the distance between two knots is always larger than the distance between two data points. This explains why even at a maximum number of knots the fit may not go through all data points. A polynomial of very high degree might achieve that, but is rather unstable.

• **I get a warning “Column STLLR\_ABSORP not found in std star table. Value 'stellar\_absorption’ in 'resp\_ignore\_mode’ is ignored” if I use the standard star tables that have been downloaded from the archive with CalSelector.**

This may happen for data from old PIPacks or for data that were downloaded before August 1, 2015, when old static calibration files were delivere. You should remove these files from your input files. Since the static calibrations are also delivered together with the latest version of the pipeline, you don’t really need them, Reflex will take the ones under directory \texttt{CALIB\_DATA\_DIR}.

• **If I change resp\_use\_flat\_sed to false for MR data the flux-calibrated data have significantly higher flux - why?**

This is due to the fact that the normalization factor for the flat field SED of the science data is derived from the standard star flat fields. For a constant lamp flux in ADU/sec this would be irrelevant. However, the flat fields for the science data are usually taken during the night at the same rotator angle as the science data. They suffer from vignetting, whose amplitude depends on the rotator angle, while the daytime calibrations are taken at an optimized rotator angle to minimize flux losses. Therefore the normalization factor derived from the standard flat fields is not correct for the science flat fields, which causes an underestimation of the flux in spectra flux-calibrated with flat field SED correction. You can correct this factor by comparing the flux in ADU/sec between the attached science flat fields and the corresponding ones taken during day time.
• The flux level of my flux-calibrated data differs substantially if I use daytime flat fields instead of the attached night time flat fields. Why?

This effect is known for volume-phase holographic (VPH) grisms and is caused by different flux levels in ADU/sec between daytime flat fields and attached night time flat fields (see previous question).

The response of VPH grisms depends on the position of the target on the detector along the dispersion axis. Because science data and flux standard stars are observed at different positions, this effect needs to be corrected during the flux calibration, because otherwise the shape of the flux calibrated data may be wrong. This is done by scaling the science and standard star data with the spectral energy distribution (SED) of their flat fields. In order to keep the overall flux scale, the flat field SED is normalized by its flux at a given reference wavelength, taking into account the slit width and exposure time. The normalization factor applied to standard star and science flat fields should be similar provided that the lamp flux in ADU/sec is similar.

However, the flux in ADU/sec varies significantly between attached flat fields and daytime flat fields, thereby distorting up the flux scale.

• Why do my flux-calibrated data not agree with independent photometric measurements?

In order to have a true absolute flux calibration several requirements need to be fulfilled:

1. All flux of both the target and the standard star needs to collected, i.e. a wide slit has to be used.
2. The transparency does not change between the observations of the target and the standard star.

With respect to the first condition one should keep in mind that the flux standard stars are observed with a 5” wide slit, while science data are typically observed with slit widths of 0.8” to 1”. For a seeing of 0.8” a slit width of 0.8”/1.0” means that some 33%/24%, respectively, of the target flux are lost (see also Fig. 8.1). This would result in a too low flux for the flux calibrated spectrum of the target.

If the second conditions is not fulfilled, i.e. the standard star or the target or both are observed under non-photometric conditions (e.g. CLR or THN) their observed flux will be lower than it should be. If the standard star is observed under photometric conditions but the science target is not the flux in the flux calibrated target spectrum will be too low. The opposite happens if the target is observed under photometric conditions but the standard star is not. CLR/THN conditions allow for transparency variations of 10%/20%, respectively.

Also the application of the flat field SED during the flux calibration can affect the absolute flux of the result (see previous question).

• Does the pipeline combine different detectors chips into a common product?

No. The spectroscopic pipeline and Reflex workflow works only on files from the same detector chip. Files from different detectors must not be mixed in the same sof.
Figure 8.1: Here a Moffat profile with a FWHM of 0.8″ is shown. The dashed and dotted lines mark the limits of a 0.8″/1.0″ slit.
9 Troubleshooting

In this section we describe some of the problems that may occur when reducing the VIMOS/MOS with the ESOrexp pipeline. For a more comprehensive description we refer the user to the VIMOS user manual (http://www.eso.org/sci/software/pipelines/).

1. I have data from the old PI packs
   The data from the DVD have to be cleaned up:
   - remove all the pipeline products i.e. master bias (whose filename contains the string MBIA), transmission response files (whose filename contains the string PTNF) and directories labelled as proc or reduced
   - remove duplicate files (i.e. files with the same name, but stored in different directories, such as arc lamps).
   - remove all old static calibrations.

2. Should I change the CALIB_DATA_DIR configuration?
   This directory is setup automatically to point to the calibration database provided with the pipeline and in principle shouldn’t be changed. However, if static calibration data are present in the RAWDATA_DIR (e.g. calibrations are downloaded from the archive, or copied from ESO-DVD distribution), then you might have to remove these data (otherwise an obsolete static calibration file may be selected instead of the most appropriate one).

3. If I set parameter resp_ignore_mode to empty in the response interactive window, the value stellar_absorption,telluric,command_line is taken
   This is a known bug in Reflex that will be solved in next release. As a work-around, set resp_ignore_mode to command_line and resp_ignore_points to empty, in order to express that no masking has to be done.

4. Bug: MODE mismatch between BIAS frames and pixel tables
   It can happen that the BIAS frames associated to the reduction flow of one MOS observation was taken in the imaging mode. The bias can be used, as there is no difference between bias taken in imaging or MOS modes. Nevertheless, the vmbias recipe requires the bias frame and the bad pixel table\footnote{CCD_TABLEs are static calibration files, one per quadrant, one set per observing mode, containing the list of bad pixels. See Section 6.2 in the VIMOS pipeline user manual (version 6.5).} to have the same observing mode. This bug can be overcome by changing the OBSMODE in the bias frames from IMG to MOS. This bug is in the vmbias recipe, independent from the reflex workflow, and it may be solved in future VIMOS pipeline releases.
References

Forchi V., 2012, Reflex User Manual, VLT-MAN-ESO-19000-5037, Issue 0.7, 

ESO VIMOS Pipeline Team, VIMOS Pipeline User Manual, VLT-MAN-ESO-19500-3355, Issue 6.6 20, 28, 29